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“Creativity is about

breaking the rules...
about trying new things.”

Linda Lee – sewer, author, teacher

“I’m always combining different colors and textures and fabrics.”
“I love to mix heavy textures with shiny things, or

dressy fabrics with ones that are more casual. For instance,
I might try a silky top and add some organza to an edge and
then put that over linen pants. I’m not afraid to combine

things that seemingly don’t go together.”

“With my Bernina, I get perfect stitches on any fabric.”
“Some people can’t sew on silk because they know their

machine won’t do it. But my Bernina performs for me, no
matter what fabric I’m working on. It’ll go from heavy wool

to chiffon to five layers of velvet without a hiccup.”
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A completely new approach to Celtic
cords, adding butterflies, birds and
beasties. Step by step photos take
Celtic designs in new directions
with new needlework techniques
that are easy, fast and efficient.
Softcover, 96 pages, color. $24.95

For the embroiderer interested in
developing new and exciting surfaces
for stitch. Challenging and innovative
surfaces are described through clear
step-by-step guidelines & over 40
different surfaces and processes to
choose from.
Softcover, 144 pages, color. $22.95

Discover your creativity as you make the
unique machine embroidered blocks for a
Latte Quilt. The CD included has all the
embroidered block patterns and is
formatted for any embroidery machine.
Softcover, 105 pages, color. $27.95

With Sew a Row you really are never
too busy to make a quilt! A magic formula

helps you make unique quilts using the
latest techniques that bring quilt making

into the 21st century. Clear diagrams and
step by step explanations show you how

to sew patchwork quickly and simply.
Softcover, color. $24.95



Currently in a garment and small quilt phase,
Jo is constantly on the lookout for quick, sim-
ple projects to share with beginning seamsters.
As Editor for BERNINA® of America, Jo is
instrumental in the production of Through the
Needle.

VICKI 
TRACY
Mirror, Mirror...
& Land that I
Love

JO LEICHTE
Contributing
Editor

As an Education Consultant for BERNINA® of
America, Jill is the resident master of stitch
manipulation. She loves playing with them,
changing them, and using them to create tex-
tured fabrics for garment and craft projects.

Finding time to sew recently, Marlene has been
creating whimsical and eclectic machine-
embroidered stitchery using the artista
Designer software. As an Education Consultant
for BERNINA® of America, Marlene focuses
much of her time on teaching dealers how to
use the artista embroidery software.

With a background in Art and Home
Economics, Susan is interested in all types of
sewing and crafts and has written several
sewing books. She loves to be creative on
paper as well as in fabric and is the Director of
Web and Education Communications for
BERNINA® of America, Inc.

Jennie Raymont is possibly the world’s only
“Nipper and Tucker.” She is a shortish, skinny-
ish, wacky Brit who is the author of three
books on fabric manipulation and surface tex-
ture with a fourth one ready in May. She trav-
els extensively, lecturing and teaching the art of
fabric manipulation.

Marlis creates unique interpretations of classic
and heirloom sewn garments, incorporating
decorative stitching techniques and embroidery
in imaginative projects. As an Education
Consultant for BERNINA® of America, Marlis
puts her own stamp of creativity on machine
sewn projects.

Vicki’s unique sense of style and her obvious
love of sewing and machine embroidery serves
her well as the owner of BERNINA® Sewing
Studio in Lubbock, TX. Her free-wheeling
approach to sewing is evident in her personal
motto – “Lighten Up. Be Fearless. Have Fun.”
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HILLERT
News from
BERNINA®

SUSAN BECK
Director of Web
and Education
Communications

An avid sewer since she was a young girl,
Gayle has managed to combine her vocation
and her avocation. As Vice President of the
Education Department for BERNINA® of
America, Inc. she is responsible for training,
education and testing functions relating to all 
BERNINA® products.

JILL 
DANKLEFSEN
Makeover Pillow
& Software Skill
Builders

NANCY 
BEDNAR
Speedy Serger 
Quilting

KAY LYNCH
BENNETT
Sprays & Such

As a Card Production
Assistant at OESD,
Inc., Kay’s job is to
assist in the develop-
ment of designs and
embroidery  cards  for

elinor peace 
bailey
The Making 
of Sophie

JENNIE
RAYMENT
Ease Your Way 
to Fabric
Manipulation

MARLENE
BRYANT
Software Skill 
Builder

MARLIS 
BENNETT
Black Tea 
Jacket

Known around the world for her whimsical
dolls, elinor shares her creative energy with
BERNINA® through Sophie, a fictional stitch-
er created to ask all those “stupid questions”
beginning sewing students are too embarrassed
to ask.

One of BERNINA®’s freelance serging experts,
Nancy also creates exquisite stitched garments,
quilts, and crafts. She is also co-author of The
Encyclopedia of Sewing Machine Techniques,
as well as author of several other books and
contributor to many sewing publications.

BERNINA® and OESD, and to create projects
using the embroidery designs. She has a BS
degree in Home Economics Education from
Oklahoma State University. She has taught
serger classes for the past 12 years at Canadian
Valley Technology Center in El Reno,
Oklahoma and at BERNINA® of OKC South.
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There’s always something happening at BERNINA® but this
spring is busier than ever! Along with the premier issue our
new Through the Needle magazine, we have new machines,
fun embroidery designs, and unique presser feet. And, on top
of that, we have BERNINA® Bonus Days coming in April!

For those of you looking for an affordable sewing and embroi-
dery machine combo, check out the newest artista sewing sys-
tem! The 165E offers artista’s exclusive ability to rescale
designs without sacrificing stitch density or design clarity, and
BERNINA®’s traditional sewing and embroidery features,
power, and ease of use are still part of the package!

If you’re already into embroidery, you’ll want to add our newest
embroidery cards to your library. If you or your children played
with Playmobil® toys you know how wonderful they are, and
you’ll love the designs on our exclusive Studio Bernina®

Playmobil® embroidery card. 

The Quiltmaker’s Gift embroidery card has designs from the
book of the same name. A sweet story of generosity and shar-
ing tells the tale of a king and a quiltmaker and the gift of quilts.
Maybe you’ll accept the challenge from BERNINA®, Quilters’
Resource, Benartex fabrics and Scholastic Books to make a
quilt for someone and enter it in our contest to win some fab-
ulous prizes for yourself. Visit the BERNINA® website for
details. 

And, don’t forget the United We
Stand embroidery card from
BERNINA® and OESD. All of the
proceeds from this unique col-
lection of patriotic-themed
embroidery designs are being
donated to the Children’s Relief
Fund of the World Trade Center
Miracles Foundation. The
designs have been contributed
by well-known designers fea-
tured on BERNINA®’s line of
licensed embroidery cards such
as Suzy’s Zoo, Debbie Mumm,

Betty Alderman, Holice Turnbow, and others. Even our favorite
new stitcher, Sophie, got in on the fun – with a little help from
her Auntie elinor!

And, more new machines
from BERNINA® — the
1200DA and the 1300DC
sergers. The 1200DA is super-
easy to thread and full fea-
tured with 2, 3, and 4 thread
stitch capabilities. The 1300
adds chain and cover stitches
for true ready-to-wear tech-
niques. With LCD screens to
guide you, professional
results are yours for every
project made with either of
these sergers. Take a visit to
your local dealer and have a
look.

We also have a new presser foot to help make the task of
inserting an invisible zipper even easier! Invisible Zipper Foot
#35 is specially designed for inserting in-seam “invisible” zip-
pers. It even eliminates the tedious job of pressing the zipper
first – the carefully engineered sole holds the zipper tape and
coils in exactly the right place for stitching. A really practical
foot to add to your collection and just in time for creating sleek
garments for spring and summer.

And if all that weren’t enough,
go to your local participating
BERNINA® dealer during April
and receive a free gift with
purchase! BERNINA® Bonus
Days offers you a free gift – a
collection of decorative
threads, notions, magazine,
pattern – valued at $35 when
you purchase $50.00 of
accessories, notions, and
supplies.

So, we hope you like your first issue of Through the Needle.
The people that created it think of themselves as a gathering
of friends sharing their sewing knowledge with you. Please
enjoy!
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BY JILL DANKLEFSEN

Give your fabric a makeover!
Take “plain” fabrics and
dress them up using pretty

threads and decorative stitches. Have fun with
several fabrics and stitch techniques, then

piece the “new” fabrics together to form the
front of a unique decorator pillow. This is a

perfect way to pull together several colors
in a room, blending them in one or two

pillows and coordinating the room’s
décor.

Start by selecting fabrics, choos-
ing firm wovens to act as a base for

your stitching. Consider experiment-
ing with different fiber contents and fab-

ric textures. This form of fabric embellish-
ment is one in which traditional rules can be
“thrown out the window.” Don’t be afraid to

try something different or unusual, perhaps
even a pieced or crinkled base. The fabrics

selected for the pillow shown here
include a wide wale cotton corduroy, a

woven wool plaid, a linen, and a solid
wool flannel.

The next step is to select decorative
threads for stitching. There are incredible

machine embroidery and specialty threads
available today. Choose from rayon, cotton, and
polyester machine embroidery threads, different

types of metallic threads, and many more.
There are no rules for determining the best

thread to use for a particular technique.
Base your decisions on your creative

likes – perhaps the color or the texture
of the thread – and stay away from the

ones that are not your favorites.

Typically, decorative threads work best
if the needle thread tension is reduced –

turned to a lower number on the tension
dial. Another way to achieve this effect is

to use a 50 wt. 3-ply cotton thread such
as Mettler Silk-Finish cotton in the

bobbin. This is a construction quali-
ty thread and therefore thicker

than many threads. A heavier thread in the bobbin helps to
make the surface stitching more definite and nicer looking.
Thus, by reducing the needle tension and using Mettler Silk-
Finish thread in the bobbin, a rich-looking decorative stitch is
achieved on the surface.

Correct needle choices are vital to success with decorative
threads and having beautifully embellished fabric(s) as an end
result. It is extremely important to have a good selection of dif-
ferent types and sizes of needles available for this kind of
work. Be sure to include the following needles in your collec-
tion - Machine Embroidery, Metafil (Metallica), Topstitching,
Microtex, Double and Triple needles. Each thread you use may
require special handling depending on the particular fabric or
stitch chosen. Having a good selection of needles available
allows for proper sample work to find just the right needle and
thread combination.

When executing the quantity of stitching that fabric embellish-
ment requires, change the needle more frequently than usual.
A dull, damaged or  burred  needle makes  working  with 

SUPPLIES:
• Assorted fabrics for piecing the 

pillow front

• 13” square fabric for the pillow back

• Assorted embroidery threads

• HTC Armo® Weft interfacing

• 11/2 yards of purchased piping

• 12” pillow form

• Hand sewing needle and thread

• Bulky Overlock Foot #12/12C

• Open Embroidery Foot #20/20C

• Embroidery Foot #6

• Small decorative cord such as Perle
Cotton or Pearl Crown Rayon
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specialty threads much more of a challenge
than it needs to be! Don’t forget to clean and
oil the machine regularly as well. A well-
lubricated hook is a necessity for good stitch
quality. Be thorough in the cleaning of the
hook area – a small bit of broken thread left
behind can cause problems far out of propor-
tion to its insignificant size.

Probably the largest “road block” to decora-
tive stitching on whole cloth is achieving
effective stabilization. On projects with a rel-
atively small decoratively stitched area, tradi-
tional “tear-away” type stabilizers work just
fine. But when faced with the magnitude of
stitching all over a large piece of fabric, tradi-
tional stabilizers may not present a good
workable option. In those cases, a weft inser-

tion interfacing presents a wonderful alterna-
tive. The Handler Textile Company manufac-
turers one such interfacing, called Armo®

Weft. Not only does this interfacing have the
ability to support many different types of dec-
orative stitching on a variety of fabrics, but it
provides additional body to the fabric base as
well. However, the best feature of this inter-
facing is that the fabric remains soft and
drapeable when the fusing process is com-
plete.

Presser feet and attachments are the final tools
necessary to complete any decorative stitch-
ing project. Keep in mind that traditional uses
for presser feet are fine, but one sometimes
has to use a presser foot or an attachment in a
different manner in order to achieve the

desired result with decorative stitching. A
good rule of thumb is to start with the presser
foot suggested for the given technique. Then
critically examine the stitching. Does it look
as nice as it could? Have you achieved the
results you expected? If the answer to either
one of the questions is “No”, consider experi-
menting with other presser feet until you are
happy with the results. Don’t forget that the
weight and type of fabric along with the stitch
selection can also effect how a presser foot
performs.

Now that you’ve assembled the necessary
tools to begin stitching your unique decora-
tively stitched fabric, it’s time to begin creat-
ing your Makeover Pillow!

- Stitch Recipes Page 6
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DIRECTIONS:
Note: All seam allowances are 1/2”.

If needed, fuse the Armo® Weft interfacing to the wrong side of the fabric swatches following the manufacturer’s direc-
tions.

Embellish each of the fabrics using one of the “stitch recipes” given on the following page. Or create your own embel-
lishment techniques and use to decorate the fabric swatches. Remember that the examples are simply a place for you
to begin creating and planning your own unique embroidered fabrics. Adjust, alter, and adapt the ideas to suit your own
creativity.

Cut the fabric pieces according to the measurements in the diagram and seam them together as shown to make a 13”
square. Using Embroidery Foot #6 and a small decorative cord, couch over the seams with the decorative stitch of your
choice.

Using Bulky Overlock Foot 
#12/12C, stitch the purchased 
piping along the raw edges of 
the pillow front, clipping the 
seam allowance at the corners 
for turning.

Place the pieced pillow front 
right sides together with the 
pillow back and stitch along all 
four sides, leaving a 6”-8”
opening on one side.

Turn the pillow to the right side 
and press if needed. Insert the 
pillow form through the opening 
and stitch the opening closed 
using a hand-sewing needle and 
thread.

Double Diamonds

Trailing Arrows

Broken Scallops

RunningAway

Double Diamonds
81/2” X 51/2” Running Away

51/2” X 61/2”

Trailing Arrows
81/2” X 81/2” Broken Scallops

51/2” X 71/2”

MEASUREMENTS ARE CUT SIZES



This is a fun, creative way to use the Half
Pattern Function. Essentially, this function
allows you to “re-arrange” the order in
which the stitch is sewn!

• Select Stitch #414 (satin stitched scallop).

• Engage Needle Stop Down.

• Engage the Half Pattern function.

• Begin sewing; the machine will automati-
cally stop sewing after sewing half of the
stitch pattern.

• Pivot 90˚ as shown.

• Continue to sew and pivot to create a diag-
onal row of stitching.

This all-over embellishment stitch is perfect for adding color

and subtle texture to flat, smooth fabrics such as wool flannel.

• Select Stitch #44 - Running Stitch, Stitch Length - 4mm and

Stitch Width - 6mm. These settings are simply suggestions;

play and experiment to find a look you like.

• Stitch back and forth across the fabric; engage the Needle

Stop Down function for easy pivoting at the ends of the rows.

• Reduce the top tension as necessary for the decorative

threads used.

Sew multiple passes of this stitch using different colors of

thread for an interesting look.
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This design works well on wide wale corduroy. The wales of the
corduroy are used as stitching guidelines.
• Insert a 2.5mm or 3.0mm double needle.
• Thread the machine using a combination of threads in contrasting
colors or perhaps in shades of the same color. Use both the hori-
zontal and vertical spool pins.
• Select a preprogrammed smocking stitch (shown is #710 of the
artista 180)
• Use the programmed stitch settings for Stitch Length.
• Adjust stitch width by engaging the Double Needle Limitation
function. Touch the function until it reads “3”.
• Reduce needle tension if needed. Sew a test to determine the
proper adjustment.
• A light-weight tear-away stabilizer may be necessary in addition 

to the interfacing.
Since there are no “official” rules for embellishing;  
don’t worry if the “Zigs” don’t match up with the 
Zags” in a neighboring row. Just sew! Stagger the 
rows as you stitch.

DOUBLE DIAMONDS

TRAILING ARROWS

RUNNING AWAY

BROKEN SCALLOPS

For more 
stitch recipes, 

go to 
www.berninausa.com

>Sewing Studio
>Sew A Stitch

This is a fun exercise - take a single stitch pattern and combine it in memory with different func-

tions and settings! This is great for defining the lines of a plaid fabric.

• Select Stitch #401 on the artista sewing machine (satin stitch triangle).

• Adjust the tension on this stitch to approximately 3 or slightly less than 3.

• Touch the external “mem” button; touch “mem 1” to open a new memory bank.

• Enter Stitch #401 into the memory 6 times.

• Touch the Pattern Begin function to go back to the beginning of 

the memory.

• Touch “edit”.

• Make the following needle position adjustments to each of the six 

patterns.
- Pattern 1 - Far right needle position

- Pattern 2 - 2 dots to the right of center needle position

- Pattern 3 - 2 dots to the left of center needle position

- Pattern 4 - Far left needle position

- Pattern 5 - 2 dots to the left of center needle position

- Pattern 6 - 2 dots to the right of center needle position

• Touch “edit” to close the window.

• Touch “store” to save the combination.

• Sew rows of this manipulated pattern along the lines of a plaid 

fabric.



Quilt with a serger?
“Why?”, you ask. Of
course sergers are widely

used little workhorses for won-
derful rolled hems, flexible knit
seams and sturdy construction with
woven fabrics. But piece and quilt on
a serger? Let’s step “outside the box”
and discuss a few reasons why you
should take a second look at what your
serger can do in an entirely different area
of sewing creativity.

Piecing is beautifully clean finished
Because a serger trims and sews at the same
time, the frayed edges created when piecing
quilt strips just do not happen. Home dec proj-
ects, such as the Log Cabin Table Topper shown
here are so cleanly finished that they could be used
wrong side up! Lining a project to cover up raw and
uneven edges is simply unnecessary.

Twice the needles equals twice the strength
A basic 4-thread overlock is the stitch of choice when
seaming woven fabrics in both garment and quilting situa-
tions. Both the right and left needles are used in this stitch
formation, doubling the seam strength. Consider using this
extra measure of “stitch security” when piecing your next quilt
intended for a little person. A much-loved project receives lots
of wear; how comforting to have that extra row of straight stitch-
ing to hold it together.

Four thread seaming controls stretchy bias edges
Simple, medium to large (4” or more) half square triangles
stretch less when seamed on a serger. The second row of
needle stitching controls the stretch on the bias edges, and
the overlocking action of the upper and lower loopers con-
tains and smooths the rippling of the seam allowances.

Piece and quilt in a flash!
Remember that a serger sews approximately two times faster than a sewing
machine. Imagine how quickly you can serge through a stack of patchwork
pieces! Use traditional speed piecing methods, chaining multiple units kite tail
style. You can also use a technique that pieces and quilts at the same time. Talk
about fast! A full-sized quilt can be completed in a fraction of the time required
by traditional methods.

Serger seam allowances
The traditional 1/4” seam allowance used in the quilting world is easily adapted
to serger piecing. The distance between the left needle and the upper cutting
blade yields an approximate 1/4” seam allowance. Markings are also imprinted
on the front of most sergers as an extra guide. For those who would like an extra
measure of accuracy, attach a BERNINA® Right Seam Guide and adjust it for a
precise 1/4” seam allowance. Position the cut edges along the seam gauge to
assure that the correct amount is trimmed and serged.

Serger quilting and piecing is “relaxed quilting”. Absolutely precise, stitch-by-
stitch seaming may not be totally possible given the physical make-up of the
serger itself. However, the speed, strength and tidiness of the finished serger
pieced project make it a technique well worth your time to explore. So, dive into
your stash, cut some strips, thread your serger and enjoy the creative ride....

For instructions on making the projects shown here log onto the BERNINA®

website at www.berninausa.com. Go to Sewing Studio>Free Projects. Search
for Log Cabin Table Topper and Fleece Lap Quilt

QUILTING
Speedy SergerSpeedy Serger
BY NANCY BEDNAR

SERGER STITCHES USED FOR QUILTING & PIECING
Two basic stitch formations are recommended for easy serger
piecing and quilting.

FOUR-THREAD OVERLOCK STITCH
Use this basic four-thread, stable stitch for both single layer
piecing and quilt-as-you-go methods using fabric and batting
at the same time.

• Right and Left Needles
• SL = 21/2 CW = 2
• All-purpose thread in both needles and both 

loopers
• All tensions balanced – 4-5 on each thread

TWO-THREAD WIDE FLATLOCK STITCH
Use this wide, stretchy seam for piecing and edging a polar
fleece throw.

• Left Needle and Lower Looper only
• Right Needle entirely removed
• Upper Looper convertor installed
• Upper Looper thread entirely removed
• SL = 3 CW = 21/2

• Wooly Nylon in both the left 
needle and upper looper

• Both tensions quite low,
3 or below on each 
depending upon the 
thickness of the fleece
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Mirror, Mirror...Mirror, Mirror...

Crewel embroidery is a form
of stitching with a colorful
history. Rather than relying

on even weave fabric, the designs
were worked freeform on linen or
wool challis. The thread most often
used was wool, which created a
matte finish and a slightly raised
texture. Most traditional crewel-
work employed stylized trees,
vines and flowers and was inspired
simply by looking out the window
at the garden. 

When stitching crewel designs, the
use of color vs. texture is an inter-
esting dilemma. Although the two
are not mutually exclusive, they
both have an effect on the overall
picture. Because color is the first
element observed in any project, it
will overshadow texture every
time. These designs are beautifully
stitched in vibrant primary colors.
However, if texture is your goal,
using low contrast (almost mono-
chromatic) colors will create a
more sophisticated look, where
texture takes center stage as shown
in the samples on page 9.

The unique mirror project shown
here is a great way to soften the
look of accessories and the good
news about this project is the
designs can be changed in the
frames as quickly as you change
your mind. It offers the perfect
way to incorporate your embroi-
dery talents into your room’s
décor. Made as picture frame, the
side panels of the mirror can be
filled with embroidered cloth just
as easily as photographs. Change
the embroidered sections often to
freshen the look of the room or
blend with the seasons.

Both designs were stitched in one
hooping using the artista large
hoop. Pivot the designs 90˚, mirror
image if desired. Hoop the batting
and fabric and stitch the designs
through both ayers.

Use the glass from the frames as a
template to cut out the designs, but
frame them without the glass.

SUPPLIES:
• Studio Bernina® Crewel 

Embroidery card by Iris Lee 

• Monet thread by YLI

• Jeans or Topstitch needle 110

• Two 10” x 12” pieces of linen 
fabric

• Two 10” x 12” pieces of low-loft 
batting

• Mirror with frames 
(4”x 6” openings)

8
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At participating dealers

There’s a curious new arrival in Bernina’s ever-growing garden of 
embroidery cards — Iris Lee’s Crewel Florals. Nowhere else on Earth will
you find such colorful and curvy specimens except in this exotic collection.
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TIPS:
Use embroidery in place of 

a photo in any frame. 
Decorator and craft stores 

have frames in many forms: 
boxes, room dividers, 
bulletin boards, etc.

For some additional ideas go to 
www.sudberry.com/catalog

When using heavy decorative 
threads for embroidery, the 

density of the design must be 
decreased; designs #31-60 on the

Studio BERNINA® Crewel 
Embroidery card by Iris Lee have 

already been adjusted for use 
with Monet thread. Insert a 

#110/16 Topstitching needle to
accommodate the diameter of the

thread, and use a bobbin filled 
with regular weight or 

bobbin thread.

At participating dealers.

The king who has everything learns that the greatest gift is generosity in the award-winning
children’s book The Quiltmaker's Gift. Now, with Bernina’s newest design card, you can 

embroider a story with these colorful characters on a quilt, on a shirt, on a pillow.



One of the extraordinary things I learned about dolls
when I first began to make them is that they have a
“voice” – my voice of course – but none the less sep-

arated enough from myself that it seems “other”. As a mat-
ter of fact, that voice became such an integral part of my

doll making that I found it useful as a communications tool for
my own sometimes overwhelming persona. The dolls seemed

to hold my anger, my strong opinions, and mollify them. Out
tumbled the words, but since they belonged to the doll they

were not quite so needy or quite so intimidating. In fact
the dolls managed to say many things that I could not

manage for myself.

Those of you who are a bit antique will recall
the film “Lili” with Leslie Caron; she falls in

love with puppets and the puppets love her
back. Not they themselves of course but
their puppeteer. He was cynical and bitter
but when he spoke through the puppets he
became sentimental and charming.
Stripped of them he was lost. Oh, you
know how it goes, she disarmed him,
found the puppet within, stripped away
his defensive veneer of self-deprecation,
and taught him to love. It’s as old a tale

as that of a child who dresses a stick in a
leaf, talking to it as if it were human.

It was this very concept that led me to create
Sophie. Here she was, able to ask all the
dumb questions that a brand new sewer
would like to ask. She’s not self-conscious
at all. Every beginner has to start at the
very beginning, but we sewers are such a

tight knit group that a new sewer feels left
out of the loop, as if she should already

know what a stitch plate is, or a selvedge.
Sophie could bring off those questions for the

beginner just like a doll brings it off for me.
So to develop Sophie I went back to my

imagination to the time when I was brand
new and knew nothing. I laid out all my

sewing tools and with the help of

Sophie
THE

OFMaking

Creating Your Own Voice!
BY elinor peace bailey
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Susan Beck and Jo Leichte at
BERNINA® of America figured
out what those tools were intend-
ed to help the sewer accomplish.
Then we told Sophie – through
Millie, her friend and teacher –
and she told you. Hopefully all
this was done with enough humor
and grace that you enjoyed being
informed.

Of course Sophie simply had to leap off the page and become a
doll. So I created her in the third dimension and presented her to
BERNINA®. You can purchase her pattern from your local BERN-
INA® dealer.

Now for those of you who are looking for a foil for your own sweet
self – remember that all your crafts, quilts and garments have a
voice. They can tell people who you are without your having to say
a word. But I’m sure you knew that. Indeed it is wonderful when
your work goes on before you, yelling, “Here she is!” when you
enter a room. But forgive me if I claim that a doll is the most direct
of speakers; and, naturally, when I came to understand that, I
became one.

Of course Sophie
simply had to 

leap off the page
and become a doll.



BERNINA® SUPPLIES:

• BERNINA® Ironing System

• artista 180E

• artista Editor Embroidery 
Software

• Edgestitch Foot #10/10C

• Embroidery Foot #15

• Button Sew-on Foot # 18

• Open Embroidery Foot #20/20C

• Patchwork Foot #37

Mini-Quilt
GENERAL SUPPLIES:

• Pattern is Heartfelt Holidays Too from Art to Heart, 
design is Land that I Love

• Scraps of assorted fabrics for backing, borders
and appliqués

• Warm & Natural® batting - approximately 20” 
square

• 1/4 yard fusible web with paper backing

• Assorted buttons

• Assorted embroidery threads

• Blush for Uncle Sam’s cheeks

• 60 wt. cotton darning thread for quilting and stippling

12

BY VICKI TRACY



Some products are just too good to be kept a secret. One such
notion is the Teflon® Pressing Sheet. Invented by a chef for
making the perfect folded omelet, it has found its way into the

sewing room. There, it has many functions:

1. Protects your iron and ironing board from the mess of 
adhesives from fusible web and iron-on interfacing

2. Use the sheet as a press cloth on any surface that should 
not touch the iron directly

3. For layered appliqué, position fused fabric shapes on the 
see-through sheet to set in place.

In addition to these sewing room uses, this sheet is great for crafts.
It will protect your table from hot glue guns, stiffening fabrics,
rubber stamps, and paint. The surface can simply be wiped clean
and reused.

The whimsical Uncle Sam on this Americana mini-quilt was lay-
ered and fused using this product. 

INSTRUCTIONS:
Cut background pieces according to
recommended sizes in pattern. Stitch
background shapes together according
to layout diagram, using Patchwork
Foot #37.

Trace appliqué shapes on paper side of
fusible webbing. Fuse to wrong side of
appropriate appliqué fabric, using a
Teflon® Pressing Sheet® to protect iron-
ing surface and iron. Cut shapes out on
traced lines.

For layered appliqué, lay the Teflon®

sheet over the pattern in the book. Peel
paper backing away and fuse fabrics
together to form one piece. Peel fused
and layered design away from Teflon®

sheet and fuse to back ground fabric.

Place batting behind fused top. Using a
Blanket Stitch, embroidery thread,
Open Embroidery Foot #20/20C, and
the far right needle position, appliqué
shapes onto background.

Select child’s play alphabet from the
Editor software and type “land that I
love” (all lower case). Send this design
to the artista 180E and embroider it on
light stripe of “flag”. Sew buttons on
using Button Sew-on Foot #18 and the
Button Sew-on Stitch.

Layer backing right sides together to
appliquéd quilt and stitch using 1/4”
seams and Patchwork Foot #37. Leave
opening for turning; turn and press,
making sure the corners are square.
Stitch the opening closed.

Stitch-in-the-ditch using Edgestitch
Foot #10/10C to secure backing to
front. Stipple stitch the background
fabrics for added texture and interest,
using Embroidery Foot #15 and 60 wt.
cotton darning thread.

13



When Jennie Rayment was asked for a
few tips on successful fabric manip-
ulation, she replied...

First, learn to love your sewing machine – it is
a girl’s best friend. It is not an ogre; it won’t
bite and it is far less intelligent than you are so
explore all the knobs and buttons and read the
instruction book! Understanding how to oper-
ate the machine to its best advantage has
helped me tremendously. For example, I use
the Blindstitch for applying any folded edges
– set the length and width at 1mm and use the
Open Embroidery Foot #20. The little bite
(indent) just catches the fold and the straight
stitch runs outside the edge. It looks like hand
stitching and will confuse all your friends.

Instead of hand tacking anything in place, use
the Darning Foot to secure any textured sec-
tions; use on the spot, jump to the next place
and repeat; on completion, trim threads.

Why not use an invisible thread/nylon fila-
ment to disguise any

wobbles or anom-
alies in the stitch-
ing? Place thread
on the top spool or
if necessary on the
bobbin and use with
cotton, silk, or any
other natural fiber.

Move the needle to change
the seam width. Simply move
the needle over, away from or
closer to the inner edge of the
presser foot (all BERNINAs do
this – it is brilliant!). Use the All-
Purpose Foot and move the needle
to a 1/4” position. Then you can zap
the machine into zigzag mode with-
out changing the presser foot and the
needle won’t break (well...not so very
often).

Second, discover the joys of fabric play. Let
your fingers squish and squash, twiddle and
fiddle. Anything that has a fold can probably
be rolled, pockets can be padded, and excess
material can be jiggled, twitched, and
tweaked into weird and wonderful shapes.
Relax about it – you can’t go wrong – it will
just be different. Many of my creations came
out of playing and experimenting. Why not
look at molded, shaped, and sculpted objects
for inspiration? My Tucked Up Circle design
came from the underside of a mushroom.
Explore other textural crafts – origami – what
happens if you do it in fabric? Maybe there
will be raw edges, but Hey! Use the serger or
turn under and secure with the Blindstitch.

Third, use a fairly firm and slightly stiff mate-
rial for all your texture work – a good crease
makes folding easier and more accurate. If

possible, avoid washing the material – the
dressing stiffens it and adds more “body”;
restore “body” to washed material with spray
starch. Natural fibers will texture; manmade
materials are mainly crease resistant.

Work with a pale colored, plain, or lightly pat-
terned cloth – it displays the nipping and tuck-
ing well. Use of heavily patterned and very
dark colors may obscure any textured effect
although black chintz can look marvelous.
Try silk, a firm satin, and any other shiny fab-
ric – the sheen enhances the textured appear-
ance.

Finally, to be a real expert in the art of fabric
manipulation, chill out and smile. If it all goes
wrong – stick a button on it or cover any wob-
bly lines of stitching with ribbon or braid.
Does it matter? It might be a great improve-
ment and lots better than the sample you were
copying. Texture deals with light and shadow
and a few more bumps and lumps will proba-
bly add to its delight. Anyone can be an expert
in my field – there’s no magic – just a case of
fiddly fingers.

14

BY JENNIE RAYMENT

Tucked Circle Wall-hanging
and Trumpet Pillow are both
from Tucks, Textures and
Pleats by Jennie Rayment.

Other books by Jennie are Tucks
& Textures Two, Tucked Up In
Bed, and Tinkering With Texture.

First, learn to love 
your sewing machine –  
It is a girl’s best friend.



JACKET

For more details on 
making this jacket, visit 
the BERNINA® website 

at www.berninausa.com
Go to Sewing Studio>

Free Projects.

This jacket combines
tea-colored fabrics
with dramatic black
for a striking and
attractive effect. 

Pieced and 
embellished with 
decorative stitching, 
it can be worn 
casually as well as 
for a dressy 
occasion.

BY MARLIS BENNETT
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It’s amazing how much of our “stitching” these
days is done without a needle and thread. As new
products have been developed, we have replaced

some of the stitching process with fusibles, adhe-
sives and glues. While the strength and beauty of
thread stitched on fabric can never be replaced, there
are some products that can make the preparation
phase of a project fast and easy. The latest of these
time-saving products is a line of sprays that make
basting and pinning a thing of the past. Look for
these sprays at the store of your local BERNINA®

dealer.

505 SPRAY AND FIX
Temporary Fabric Adhesive

Many of us are somewhat familiar with “temporary
fabric adhesives.” 505 holds two pieces of fabric
together (for up to 6 months) until they are pulled
apart and exposed to air. The adhesive begins to de-
activate when exposed to air and will completely
dissipate within 24 to 48 hours.

For machine embroidery work, 505 is used to adhere
stabilizer to the garment either before or after hoop-
ing. Securing the stabilizer to the fabric before hoop-
ing helps prevent accidental stretching and distorting
of the fabrics as the garment is hooped. This is espe-
cially important when embroidering knit fabrics. To
apply, spray the stabilizer with a light coating of
505. Adhere the stabilizer to the wrong side of the
garment in the area to be embroidered. Gently
smooth out any wrinkles taking care to not stretch
the garment.

In instances where hooping is impractical (small
areas of a garment such as cuffs and collars, or thick
fabrics that are hard to hoop), hoop the stabilizer
first and then spray the hooped stabilizer with 505.
Place the area to be embroidered over the sprayed
area and gently smooth out any wrinkles. Take care
to not stretch the fabric as you are placing it on the
hooped area.

505 is also great for “basting” quilt layers together
before machine or hand quilting. It does not cause
the needle to gum up, and is odorless, colorless,
stainless, and spotless. It contains no CFC’s and is
acid free. Excess 505 cleans up with soap and water,
excessive buildup of 505 can be removed with
Murphy’s Oil Soap or drycleaned.

202 SPRAY AND FIX
Temporary Adhesive

This temporary adhesive is a “light” version of 505.
It can be used when a lighter application of tempo-
rary adhesive is desired. Use it to hold tissue patterns

in place when cutting out a garment. Spray the
wrong side of the pattern piece with 202 and let dry
for a few minutes. Patterns can be repositioned as
needed. The adhesive begins to dissipate when
exposed to air, but can be reapplied several times.

202 can be applied to paper patterns or templates of
any kind, and will adhere to many surfaces, includ-
ing wood. It is used by wood hobbyists to hold pat-
terns in place while cutting. The pattern may be
removed and used several times. Apply additional
202 after several uses. The adhesive begins to dissi-
pate when exposed to air, and will be completely
gone within 24 to 48 hours.

It is stainless, spotless, does not gum scissors, saws,
or needles, contains no CFC’s and is acid free.

404 SPRAY AND FIX
Permanent Repositionable 

Craft Adhesive
Think of this as “sticky note” spray. The adhesive is
sprayed onto the back of fabric or paper. The adhe-
sive remains permanently affixed to that object. This
fabric or paper can then be applied to another sur-
face and removed or repositioned as needed; the
adhesive will not transfer onto other surfaces.

404 is great for crafters and scrap bookers. Since it
is acid free, it can be applied to the backs of photo-
graphs. The photographs will remain in place until
they are removed. It is acid free and contains no
CFC’s.

606 SPRAY AND FIX
Spray on Fusible Web

Available exclusively from Oklahoma Embroidery
Supply and Design, 606 is a permanent spray used to
make any fabric or stabilizer an “iron-on.” Applied
to the wrong side of the fabric to be fused, 606 spray
allows you to create iron-on stabilizers or appliqués.
Spray several light coats onto the back of the sur-
face. The more coats, the stronger the bond will be
when fused in place. The appliqué should be satin
stitched or edge stitched to securely hold it in place
for laundering. 606 is acid free and contains no
CFC’s.

FABRIC SHIELD
Fabric Protector

Fabric Shield is used to protect fabrics from dust and
dirt, spills, grease and oil; it is water repellent. Spray
surface to be treated from about 6” away. Fabric
Shield can be laundered and drycleaned. It is acid
free, and contains no CFC’s. As with any aerosol
container, care should be taken to keep cans from
extremely high temperatures.

BY KAY LYNCH BENNETT
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Pattern Outlines
BY MARLENE BRYANT & JILL DANKLEFSEN
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The 175 options of preprogrammed Pattern Outlines are avail-
able on any level of artista software and can be manipulated
as described below. To use one of the Pattern Outlines, draw

any shape using the appropriate tool. Next, select the Outline option
at the lower left of the screen; select the Pattern option. To change
the pattern, go to the Object Properties box under Settings. The
Outline Stitch tab has the choices divided into 10 categories.

The easiest way to manipulate a pattern outline is by altering
the size. This is done in the Object Properties box. By chang-
ing the Size and Spacing it is possible to enlarge or reduce

the pattern. If you are a more visual person, then use the resizing
arrows in the Reshape Object view.

Another form of pattern outline manipulation is achieved using the
diamonds above each segment of the pattern outline. Using the
Reshape Object tool, click and drag the patterns to respace along
the baseline. Notice the black squares on each end of the baseline.
By clicking and dragging the boxes, the line can be increased or
decreased in length, creating a better fitting pattern outline for a
prescribed shape or distance.

For ultimate design freedom, create your own unique pattern
outline. A pattern outline can be created with a single straight
stitch or with satin stitching. The pattern below was created

using the artista Designer Software. 

To begin this pattern, choose the Closed Curve tool; select Satin
Fill. Create a half circle 5mm long by 3.5mm high. 

Click the Reshape Object tool and move the entrance point to
the lower left corner. Place the exit point on the lower right
corner. Change the stitch angle to 90º using the angle adjust-

ment line. Press enter on the keyboard to accept the changes to the
half circle. 

Now select the half circle. Duplicate it, then mirror it horizontally.
Move it to the right of the original half circle. Drag a selection box
around both elements. 

Click on Settings>Create Pattern. Name your new pattern Opposite
Scallops. Click OK in the dialog box. Now designate where the pat-
tern should begin by left clicking on the lower left corner of the
design. Left click on the lower right corner to designate where you
would like the pattern to repeat. A dialog box will appear indicating
that your new pattern named Opposite Scallops is created.

One of the special features of the artista Embroidery Software is the collection of Pattern Outlines. Choose from 175 different outlines
and use them to replace existing outlines, add decorative borders and accents, create decorative stitch appliques, and add texture to back-
grounds. The Designer level of artista software adds the ability to create one’s own pattern outlines.

Check this page in each issue of Through The
Needle to sharpen your artista software skills

Selecting Pattern Outlines

Manipulating Pattern Outlines

tipWhen creating a pattern outline around an object, it 
is best to create the outline in segments or sides. It 
will fit the object more precisely, and turning corners
cleanly is easier than trying to straddle or overlap a
corner.

tipChanging the grid to 5mm by 5mm makes creating 
patterns easier.

Creating Pattern Outlines



tip
The stitched “backdrop” of this embroidered sunflower

appears to be stitched with a sewing machine – but look at
the design closely. It was created using the pattern outline

stitches of the artista embroidery software! Follow the steps below
to create your own unique stitched fabrics.

Open the software and set up a grid appropriate for your stitches:
select Settings>Options>Grid, then set horizontal and vertical spac-
ing as desired. 

While in the Options box, select the Hoop tab. In the Position box,
turn off the Automatic Centering feature by selecting Manual.
Touch OK. Zoom out to see the entire hoop on screen. 

In Design mode, select Outline>Pattern. Select the Open Curve
tool, then use left mouse clicks to create vertical lines of stitches as
shown in the illustration. Digitize each line separately by pressing
Enter after each row.  

Assign a pattern outline stitch to the rows by choosing Edit>Select

All, then right clicking on the Object Properties box. The Outline
Stitch tab should already be selected; from the Pattern box, click
Select to open the pattern outline stitch menu. Select the desired
stitch, then click OK. In a few seconds the newly created stitches
appear. To view them more realistically, select the Artistic View tab. 

Select Settings>Options. Reselect the Automatic Centering func-
tion. 

Select Edit>Select All; click on the General tab to view the finished
size of the stitched area. Adjust if necessary, then click OK. 

Select File>Save As; name the design, then click OK. 

Combine your pattern outline stitch background with other designs
using the software or the on-screen editing features of the artista
sewing system.
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All of the pattern outline stitches can be viewed in the
online manual which is accessed from the Help menu
of the artista software.  

The flowers shown here are design #FL255
from OESD and the stitch used as a back-
drop is #641 from CPS software.

Pattern Outline Exercise



Professional
Profile
Professional
Profile Education Editor, BERNINA® of America

WHAT IS YOUR JOB?I work at BERNINA® of America in Aurora, IL, creating print publications 
such as Feet-ures and the Sophie Learns to Sew series, as well as writing, 
editing and working on articles for our website: www.berninausa.com. Even 
though I’m officially an editor, I also write, illustrate, proof, oversee photography, 
lay out pages, design projects, and even occasionally sew a bit.HOW DID YOU ARRIVE AT YOUR CURRENT POSITION?Most people assume that I have a background in Home Economics, but actually I have a Bachelor of 

Science in engineering plus a Master of Fine Arts in Environmental Design (a field which encompasses 

architecture and product design). That sounds like an odd mix, but engineering is a great background 

for any profession as it teaches creative problem solving – breaking things down into smaller pieces, 

analyzing how things work (or why they don’t), figuring out how pieces fit together to form a whole. Art 

adds a foundation in good aesthetic design. My plan was to eventually become an architect or furniture 

designer, but I became sidetracked when I started working part-time for a BERNINA® dealer while in 

graduate school.

I’d been sewing and making clothes since I was about 10, and designing and constructing costumes and 

formal wear since 1980, but working at a BERNINA® store was my first experience with really wonderful 

sewing machines that would easily stitch anything I could imagine. Attending BERNINA® University in 

1989 was my first exposure to the BIG world of sewing – independent pattern companies, sewing notions, 

teachers that seemed to know EVERYTHING about sewing – it was great! I’ve been a BERNINA® fan ever 

since. After graduation I worked with museums, including developing an exhibit on textile science for 

Discovery Place in Charlotte, NC. I found that I really enjoyed researching and developing educational 

exhibits, and that I not only liked writing but was pretty good at it, too (a big thank-you to Martha Morgan, 

my high school English teacher!). At the same time I also started working part-time for the local BERNINA®

dealer.

Eventually I applied for a job with BERNINA® as a Training Consultant; while I didn’t get that job, I was 

offered a part-time position assisting Susan Beck, who was then the Education Editor. It was a perfect fit! 

Finally, three years ago I was offered a full-time position as Assistant Education Editor – if I would move 

from NC to Chicago! – and last year was promoted to Education Editor. If that’s not a circuitous path, I don’t 

know what is!

WHAT DO YOU LIKE BEST ABOUT YOUR JOB?That there’s always something new and different! One day I might spend writing instructions for a set of 

training manuals, another laying out photos for an embroidery brochure, and the next illustrating projects for 

a book on sewing techniques. Then a photo shoot, and assembling a page from Sophie’s Journal for the 

website. I’m always busy, and I’m never bored. And I get to work with some of the most creative and talented 

people I’ve ever met – BERNINA®’s team of Trainers and Education Consultants, and stitchers and designers 

from all over the world.
DO YOU SEW? IF SO, WHAT IS YOUR FAVORITE THING TO STITCH?
Lately I’ve been making lots of small quilting projects – really easy patterns that go together quickly – 

foundation piecing, log cabin blocks, crazy patch, sweatshirt jackets. Since my editing work is so detail-

oriented, I like to push myself in the other direction by playing with very unstructured techniques in my free 

time. I also love constructing garments with my serger, especially sweater knits and fleece. I get lots of project 

ideas from my sewing students – I teach a class called “Sewing Fairy Godmother” in which students work on 

their projects and I provide assistance as needed – it’s like a little sewing party once a week!ANY LAST THOUGHTS?Live your dream – once you discover your heart’s desire, follow it – we don’t often get a second chance to 

follow our dreams. I have a job that I love – I can’t imagine doing anything more fun or fulfilling.

JO LEICHTE

Not everyone
who works in the
sewing industry
is a full-time
seamstress. 

From pattern 
designers to 
embroidery 
digitizers to 
notions buyers, 
it takes a 
multitude of 
skills to keep 
the industry 
moving. 

Meet people
with interesting
jobs and find out
how they got
there.
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PORTRAIT
of the

ARTIST
with her

BERNINA

“I create what’s in my

heart...
That’s what makes me the happiest.”

Hollis Chatelain –  textile artist, photographer

“This is a quilt about good friends of mine, people I really care about.”
“It’s a way for me to put myself back in Africa, a place I lived for over a
decade. I just love the people, and this is a way for me to be with them,
to talk to them, to feel their feelings. I start with the thousands of

photographs I took out there, and then I finish by quilting the people
in a full range of colored threads.”

“I can sew on my Bernina for 14 hours, and it doesn’t do anything wrong.”
“I never get thread throw-up. You know, when you start to sew and you

get this huge glob of thread that you have to stop and cut. With my
Bernina, the stitching is beautiful. Plus, I can switch from a 50 weight
rayon to a 30 weight cotton and never even have to adjust my thread

tension. It’s very easy to use.”

©2002 Bernina of America • Visit www.berninausa.com for a dealer near you.




